0. Laboratory - Network Design (Planning a Network with Different Users, Hosts, and Services)

4. Laboratorijska vježba – dizajniranje mreže (planiranje mreže s različitim korisnicima, domaćinima i uslugama)

Objective

Zadatak

The objective of this lab is to demonstrate the basics of designing a network, taking into consideration the users, services, and locations of the hosts.

Zadatak ove laboratorijske vježbe je pokazati osnove dizajniranja mreže, uzimajući u obzir korisnike, usluge i lokacije domaćina.

Overview

Pregled

Optimizing the design of a network is a major issue. Simulations are usually used to analyze the conceptual design of the network. The initial conceptual design is usually refined several times until a final decision is made to implement the design. The objective is to have a design that maximizes the network performance, taking into consideration the cost constraints and the required services to be offered to different types of users. After the network has been implemented, network optimization should be performed periodically throughout the lifetime of the network to ensure maximum performance of the network and to monitor the utilization of the network resources.

Optimizacija dizajna mreže je značajna stavka. Simulacije se obično koriste za analizu konceptualnog dizajna mreže. Početni konceptualni dizajn se obično nekoliko puta dorađuje  dok se ne donese konačna odluka o izvedbi dizajna. Zadatak je imati dizajn koji maksimalizira rad mreže, uzimajući u obzir troškovna ograničenja i da su tražene usluge ponuđene različitim korisnicima. Nakon što je mreža pokrenuta, optimizacija mreže se mora obavljati periodično za vrijeme postojanja mreže kako bi se osigurao maksimalan rad mreže i kako bi se nadgledala upotreba resursa mreže.

In this lab you will design a network for a company that has four departments: Research, Engineering, E-Commerce, and Sales. You will utilize a LAN model that allows you to simulate multiple clients and servers in one simulation object. This model dramatically reduces both the amount of configuration work you need to perform and the amount of memory needed to execute the simulation. You will be able to define a profile that specifies the pattern of applications employed by the users of each department in the company. By the end of this lab, you will be able to study how different design decisions can affect the performance of the network.

U ovoj laboratorijskoj mreži ćete dizajnirati mrežu za tvrtku koja ima četiri odijeljenja: Istraživanje, Inžinjerstvo, Elektronička trgovina i Prodaja. Upotrijebiti ćete LAN model koji vam omogućuje simulaciju mnoštva klijenata i servera u jednoj simulaciji. Ovaj model značajno umanjuje broj konfiguracija koje vam trebaju za izvedbu i količinu memorije koja je potrebna za izvođenje simulacije. Trebali biste definirati profil koji određuje uzorak aplikacija koje će korsititi zaposlenici svakog odijeljenja tvrtke. Do završetka ove vježbe, trebali biste moći pručiti kako različite odluke o dizajnu mogu utjecati na rad mreže.

Prelab Activities
Pripremne  aktivnosti

· Read section 3.2 from "Computer Networks: A Systems Approach", 4th Edition.

· Pročitajte odjeljak 3.2 iz "Computer Networks: A Systems Approach", 4. izdanje.

Go to www.net-seal.net/animations.php and play the following animations:

Idite na  www.net-seal.net/animations.php i pokrenite sljedeće animacije:

· Adding Switches.

· Dodavanje Switcheva
Procedure

Postupak

0.1.1. Create a New Project

Kreiranje novog projekta

Start OPNET IT Guru Academic Edition ( Choose New from the File menu.
1. Pokrenite OPNET IT Guru Academic Edition ( odaberite New iz File izbornika.
Select Project and Click OK ( Name the project <your initiaIs>_NetDesig, and the scenario SimpleNetwork ( Click OK.

2. Označite Project i kliknite OK ( Nazovite projekt <your initiaIs>_NetDesig, a scenarij SimpleNetwork ( kliknite OK.

In the Startup Wizard Initial Topology dialog box, make sure that Create Empty Scenario is selected ( Click Next ( Choose Campus from the Network Scale list ( Click Next ( Choose Miles from the Size drop-down menu and assign 1 for both X Span and Y Span ( Click Next twice ( Click OK.

3. U Startup Wizard Initial Topology dijaloškom okviru, provjerite  je li Create Empty Scenario označen ( kliknite Next ( odaberite Campus na Network Scale listi ( kliknite Next ( odaberite Miles u Size padajućem izborniku i pripišite 1 i za X Span i Y Span ( kliknite dva puta Next ( kliknite OK.

0.1.2. Create and Configure the Network

Kreiranje i konfiguracija mreže

Initialize the Network:

Pokretanje mreže:

The Object Palette dialog box should be now on the top of your project space. If it is not there, open it by clicking 
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. Make sure that the internet_toolbox is selected from the pull-down menu on the object palette.

1. Object Palette dijaloški okvir trebao bi biti na vrhu vašeg projektnog prostora. Ako nije tamo, otvorite ga klikom na [image: image2.png]


. Provjerite je li internet_toolbox označen u padajućem izborniku na object palette.

Add to the project workspace the following objects from the palette: Application Config. Profile Config, and a subnet.

2. Dodajte na projektnu radnu površinu sljedeće objekte iz palete: Application Config. Profile Config, i subnet.

To add an object from palette, click its icon on the object palette. ( Move your mouse to the workspace. ( Left click to place the object. Right-click when finished. The workplace should contain the following three objects:

a. Za dodavanje objekta iz palete, kliknite na njegovu ikonu u object palette. ( Pomaknite miš na radnu površinu. ( Lijevim klikom smjestite objekt. Desnim klikom završite. Radna površina bi trebala sadržavati sljedeća tri objekta:
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Close the Object Palette dialog box and save your project.

3. Zatvorite Object Palette dijaloški okvir i spremite svoj projekt.

Application Config is used to specify application that will be used to configure user’s profiles.

Application Config se koristi za određivanje aplikacije koja će se koristiti za konfiguraciju korisnikova profila. 

Profile Config describes the activity patterns of a user or group of users in terms of the applications used over a period of time. You must define the applications using the Application Config object between using this object
Profile Config opisuje uzorke aktivnosti svakog korisnika ili grupe korisnika pomoću aplikacije koja se koristi neko vrijeme. Morate definirati aplikacije koristeći Application Config objekt između korištenja objekta.  
Configure the Services:

Konfiguriranje usluga:

Right-click on the Application Config node ( Edit Attributes Change the name attribute to Applications ( Change the Application Definitions attribute to Default ( Click OK.
1. Desno kliknite na Application Config čvor ( Edit Attributes promijenite name atribut u Applications ( promijenite Application Definitions atribut u Default ( kliknite OK.
Right-click on the Profile Config node ( Edit Attributes ( Change the name attribute to Profiles ( Change the Profile Configuration attribute to Sample Profiles ( Click OK.

2. Desno kliknite na Profile Config node ( Edit Attributes ( promijenite name atribut u Profiles ( promijenite Profile Configuration atribut u Sample Profiles ( kliknite OK.

Sample Profiles provides patterns of applications employed by users such as engineers, researchers, salespeople, and multimedia users.

3. Sample Profiles pruža uzorke aplikacija koje koriste inžinjeri, istraživači, pradavači i korisnici multimedije.

Configure a Subnet:

Konfiguracija podmreže:

Right-click on the subnet node ( Edit Attributes ( Change the name attribute to Engineering and Click OK.

1. Desno kliknite na subnet žarište ( Edit Attributes ( promijenite name atribut u Engineering i kliknite OK.

Double-click on the Engineering node. You get an empty workspace, indicating that the subnet contains no objects.

2. Dva puta kliknite na  Engineering čvor. Dobiti ćete praznu površinu, što potvrđuje da podmreža ne sadrži objekte .

Open the object palette 
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 and make sure it is still set to internet_toolbox.

3. Otvorite object palette [image: image5.png]


 and i provjerite je li još podešena na  internet_toolbox.

Add the following items to the subnet workspace: 10BaseT LAN, ethernet16 Switch, and a 10BaseT link to connect the LAN with the Switch ( Close the palette.

4. Na radnu površinu dodajte sljedeće: 10BaseT LAN, ethernet16 Switch, i 10BaseT link kako bi povezali LAN sa Switchom ( Zatvorite palette.

Right-click on the 10BaseT LAN node ( Edit Attributes ( Change the name attribute to LAN Observe that the Number of Workstations attribute has a value of 10 Click in the Value column for the Application: Supported Profiles attribute, and select Edit. You should get a table in which you should do the following:

5. Desno kliknite na 10BaseT LAN čvor ( Edit Attributes (  Promijenite name atribut u LAN Observe tako  da Number of Workstations atribut ima 10. Kliknite na Value stupac zbog Application: Supported Profiles atributa, i odaberite Edit. Trebali biste dobiti tablicu u kojoj trebate napraviti sljedeće:

Set the number of rows to 1.

a. Postavite broj rows na 1.

Set the Profile Name to Engineer. Note: Engineer is one of the "sample" profiles provided within the Profile Config object.

b. Postavite Profile Name kao Engineer. Napomena: Engineer je jedan od "probnih" profila iz Profile Config objekta.

Click OK twice.

c. Kliknite dva puta OK.

The object we just created is equivalent to a 10-workstation star topology LAN. The traffic generated from the users of this LAN resembles that generated by "engineers."

Objekt koji smo upravo kreirali je jednak 10-ostaničnoj zvjezdanoj topologiji LAN. Promet zagarantiran od korisnika ovog LAN-a nalikuje onome kojeg ostvaruju "inžinjeri."

Rename the ethernet16 Switch to Switch.

6. Preimenujte ethernet16 Switch u Switch.

The subnet should look like the shown one.

7. Podmreža bi trebala izgledati kao na sljedećem prikazu.

Save your project.

8. Spremite svoj projekt.
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Configure All Departments:

Konfiguracija svih odjela:

Now you have completed the configuration of the Engineering department subnet. To go back to the main project space, click the Go to the higher level 
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 button.

1. Sada ste dovršili konfiguraciju podmreže inžinjerskog odjela. Kako bi se vratili na glavnu projektnu površinu, kliknite Go to the higher level [image: image8.png]


 tipku.

The subnets of the other departments in the company should be similar to the engineering one except for the supported profiles.

Podmreže ostalih odjela tvrtke biti će slične inžinjerskoj osim profila za podršku. 

Make three copies of the Engineering subnet we just created: Click on the Engineering node ( From the Edit menu, select Copy. From the Edit menu, select Paste three times, placing the subnet in the workspace after each, to create the new subnets.

2. Napravite tri kopije Engineering podmreže koju smo upravo kreirali: kliknite na Engineering čvor ( U Edit izborniku, označite Copy. U Edit izborniku, označite Paste tri puta, smještajući podmrežu na radnu površinu nakon svakog puta, kako biste kreirali nove podmreže.

Rename (right-click on the subnet and select Set Name) and arrange the subnets as shown bellow:

3. Preimenujte (desno kliknite na podmrežu i označite set Name) i poredajte podmreže kao što je dolje prikazano:
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Double-click the Research node ( Edit the attributes of its LAN ( Edit the value of the Application: Supported Profiles attribute. ( Change the value of the Profile Name from Engineer to Researcher ( Click OK twice ( Go to the higher level by clicking the 
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 button.

4. Dva puta kliknite na Research čvor ( Edit atribute LAN-a ( Edit vrijednost Application: Supported Profiles atributa. ( Promijenite vrijednost Profile Name iz Engineer u Researcher ( Kliknite dva puta OK ( Go to the higher level klikanjem na [image: image11.png]


 tipku.

Repeat step 4 with the Sales node and assign to its Profile Name the profile Sales Person.
5. Ponovite 4. korak sa Sales čvorom i pripišite njegovom  Profile Name profil Sales Person.
Repeat step 4 with the E-commerce node and assign to its Profile Name the profile E-commerce Customer.
6. Ponovite 4. korak s E-commerce čvorom i pripišite njegovom Profile Name profil E-commerce Customer.
Save your project.

7. Spremite svoj projekt.

Configure the Servers:

Konfiguracija servera:

Now we need to implement a subnet that contains the servers. The servers have to support the applications defined in the profiles we deployed. You can double-check those applications by editing the attributes of our Profile node. Inspect each row under the Applications hierarchy, which in turn, is under the Profile Configuration hierarchy. You will see that we need servers that support the following applications: Web browsing, Email, Telnet, File Transfer, Database, and File Print.

Sada trebamo osmisliti mrežu koja sadrži servere. Serveri moraju podržavati aplikacije definirane u profilima koje smo postavili. Možete ponovno provjeriti te aplikacije uređivanjem atributa našeg Profile čvora.  Provjerite svaki redak u Applications hijerarhiji, koji je u Profile Configuration hijerarhiji. Vidjeti ćete da trebamo servere koji podržavaju sljedeće aplikacije:  Web browsing, Email, Telnet, File Transfer, Database, i File Print.

Open the Object Palette 
[image: image12.png]


 and add a new subnet ( Rename the new subnet to Servers ( Double-click the Servers node to enter its workspace.

1. Otvorite Object Palette [image: image13.png]


 i dodajte novu subnet ( preimenujte novu podmrežu u Servers ( Dva puta kliiknite na Servers čvor kako bi ušli na njegovu radnu površinu.

From the Object Palette, add three ethernet_servers, one ethernet16_switch and three 10BaseT links to connect the servers with the switch.

2. Iz Object Palette, dodajte tri ethernet_servers, jedan ethernet16_switch i tri 10BaseT linka kako bi spojili servere sa switch-om.

Close the Object Palette.
3. Zatvorite Object Palette.
Rename the servers and the switch as follows:

4. Preimenujte servere i switch kako je dolje prikazano:
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Right-click on each one of the above servers and Edit the value of the Application: Supported Services attribute.

5. Desno kliknite na svaki od servera i Edit vrijednost Application: Supported Services atributa.

For the Web Server add four rows to support the following services: Web Browsing (Light HTTP1.1) Web Browsing (Heavy HTTP1.1), Email (Light), and Telnet Session (Light).
i. Za Web Server dodajte četiri retka za podržavanje sljedećih usluga: Web Browsing (Light HTTP1.1) Web Browsing (Heavy HTTP1.1), Email (Light), i Telnet Session (Light).
For the File Server add two rows to support the following services: File Transfer (Light) and File Print (Light).
ii. Za File Server dodajte dva retka za podržavanje sljedećih usluga: File Transfer (Light) i File Print (Light).
For the Database Server add one row to support the following service: Database Access (Light).
iii. Za Database Server dodajte jedan redak za podržavanje usluge: Database Access (Light).
Go back to the project space by clicking the Go to the higher level 
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 button.

6. Vratite se na projektnu površinu klikom na Go to the higher level [image: image16.png]


 .

Save your project.

7. Spremite svoj projekt.

Connect the Subnets:

Povezivanje podmreža:

Now all subnets are ready to be connected together.

Sada su sve podmreže spremne za međusobno povezivanje.

Open the Object Palette 
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 and add four 100BaseT links to connect the subnets of the departments to the Servers subnet.

1. Otvorite Object Palette [image: image18.png]


 i dodajte četiri 100BaseT linka kako biste povezali podmreže odjela sa serverskom podmrežom.

As you create each link, make sure that it is configured to connect the "switches" in both subnets to each other. Do this by choosing them from the drop-down menus as follows:

Dok kreirate link, provjerite je li konfiguriran za međusobno spajanje "switches". Učinite to itako da ih izaberete iz padajućih izbornika kako je prikazano:

[image: image19.png]rodea

nadeb

t Nodes.

ResearchSwitch

Servers Server Suitch

Cancel

oK





Close the Object Palette.

2. Zatvorite Object Palette.

Now your network should resemble the following one:

3. Sada bi vaša mreža trebala nalikovati dolje prikazanoj:
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Save your project.

4. Sačuvajte svoj projekt.

Choose the Statistics

Biranje statistika

To test the performance of our network we will collect one of the many available statistics as follows:

Kako biste testirali rad naše mrežesakupiti ćemo jednu od mnogih statistika na sljedeći način:

Right-click anywhere in the project workspace and select Choose Individual Statistics from the pop-up menu.
1. Desno kliknite bilo gdje na projektnu radnu površinu i označite Choose Individual Statistics u lebdećem izborniku.
In the Choose Results dialog box, choose the following statistic:

2. U Choose Results dijaloškom okviru, odaberite sljedeće statistike:
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Page Response Time is the required time to retrieve the entire page.

Page Response Time je vrijeme potrebno za vraćanje čitave stranice.

Click OK.

3. Kliknite OK.

0.1.3. Configure the Simulation

Konfiguracija simulacije

Here we need to configure the duration of the simulation:

Sada trebamo konfigurirati trajanje simulacije:

Click on the Configure/Run Simulation 
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 button.

1. Kliknite na Configure/Run Simulation [image: image23.png]


.

Set the duration to be 30.0 minutes.

2. Postavite trajanje na 30.0 minuta.

Press OK.
3. Stisnite OK.
0.1.4. Duplicate the Scenario

Udvostručenje scenarija

In the network we just created we assumed that there is no background traffic already in the links. In real networks, the links usually have some existing background traffic. We will create a duplicate of the SimpleNetwork scenario but with background utilization in the 100BaseT links.

U mreži koju smo upravo kreirali, pretpostavili smo da već nema pozadinskog prometa u linkovima. Kod stvarnih mreža, linkovi obično imaju već postojeći pozadinski promet. Kreirati ćemo duplikat SimpleNetwork scenarija, ali s korištenjem smetnji u 100BaseT linkovima.

Select Duplicate Scenario from the Scenarios menu and give it the name BusyNetwork ( Click OK.

1. Označite Duplicate Scenario u Scenarios izborniku i nazovite ga BusyNetwork ( kliknite OK.

Select all the 100BaseT links simultaneously (click on all of them while holding the Shift key) ( Right-click on anyone of them ( Edit Attributes ( Check the Apply Changes to Selected Objects check box.

2. Označite sve 100BaseT linkove istovremeno (kliknite na sve njih dok držite tipku Shift) ( desno kliknite na bilo koji od njih ( Edit Attributes ( označite Apply Changes to Selected Objects.

Expand the hierarchy of the Background Utilization attribute ( Expand the row 0 hierarchy ( Assign 99 to the background utilization (%) as shown below.

3. Proširite hijerarhiju Background Utilization atributa ( proširite row 0 hijerarhiju ( pripišite 99 u background utilization (%) kako je dolje prikazano.
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Click OK.

4. Kliknite OK.

Link utilization is the percentage of the used link bandwidth.

Link utilization je postotak korištenog raspona linka.

0.1.5. Run the Simulation

Pokretanje simulacije

To run the simulation for both scenarios simultaneously:

Za pokretanje simulacije za oba scenarija istovremeno:

Go to the Scenarios menu ( Select Manage Scenarios.
1. Idite na Scenarios izbornik ( označite Manage Scenarios.
Change the values under the Results column to <collect> (or <recollect>) for both scenarios. Compare to the following figure.

2. Promijenite vrijednosti u Results stupcu u <collect> (ili <recollect>) za oba scenarija. Usporedite sa sljedećim prikazom.
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Click OK to run the two simulations. Depending on the speed of your processor, this may take several seconds to complete.

3. Kliknite OK za pokretanje dviju simulacija. Ovisno o brzini vašeg procesora, ovo može potrajati nekoliko sekundi. 

After the two simulation runs complete (one for each scenario), click Close.

4. Nakon što su dvije simulacije dovršene (jedna za svaki scenarij), kliknite na Close.

Save your project.

5. Spremite svoj projekt.

0.1.6. View the Results

Pregled rezultata

To view and analyze the results:

Za pregled i analizu rezultata:

Select Compare Results from the Results menu.

1. Označite Compare Results u Results izborniku

Change the drop-down menu in the lower-right part of the Compare Results dialog box from As Is to time_average as shown.

2. Promijenite padajući izbornik u donjem desnom dijelu Compare Results dijaloškog okvira iz As Is u time_average kako je dolje prikazano.
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Select the Page Response Time (seconds) statistic and click Show. The resulting graph should resemble the one below. (Note: Results may vary slightly due to different node placement.)

3. Označite Page Response Time (seconds) statistiku i kliknite na Show.Rezultirajući grafikon bi trebao nalikovati dolje prikazanom. (Napomena: Rezultati mogu malo varirati zbog različitog smještaja čvorova.)
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5. Further readings

6. Dodatna literatura

· OPNET Configuring Applications and Profiles: From the Protocols menu, select Applications ( Model Usage Guide ( Configuring Applications and Profiles.

· OPNET Configuring Applications and Profiles: U Protocols izborniku, označite Applications ( Model Usage Guide ( Configuring Applications and Profiles.

7. Exercises

8. Vježbe

Analyze the result we obtained regarding the HTTP page response time. Collect four other statistics, of your choice, and rerun the simulation of the Simple and the Busy network scenarios. Get the graphs that compare the collected statistics. Comment on these results.
1) Analizirajte dobiveni rezultat s obzirom na vrijeme odgovora HTTP stranice. Prikupite još četiri statistike, po vlastitom iboru, i ponovno pokrenite simulaciju Simple i Busy scenarije mreže. Izradite grafikone koji uspoređuju dobivene statistike. Komentirajte te rezultate.  
In the BusyNetwork scenario, study the utilization% of the CPUs in the servers (Right-click on each server and select Choose Individual Statistics ( CPU ( Utilization).

2) U BusyNetwork scenariju, proučite utilization% CPU-a u serverima (desno kliknite na svaki server i odaberite Choose Individual Statistics ( CPU ( Utilization).

Create a new scenario as a duplicate of the BusyNetwork scenario. Name the new scenario Q3_OneServer. Replace the three servers with only one server that supports all required services. Study the utilization% of that server's CPU. Compare this utilization with the three CPU utilizations you obtained in the previous exercise.

3) Kreirajte novi scenarij kao duplikat BusyNetwork scenarija. Nazovite novi scenarij Q3_OneServer. Zamijenite tri servera sa samo jednim serverom koji podržava sve tražene usluge. Proučite utilization% serverovog CPU-a. Usporedite ovu upotrebu s tri CPU upotrebe koje ste dobili u prethodnoj vježbi.

Create a new scenario as a duplicate of the BusyNetwork scenario. Name the new scenario Q4_FasterNetwork. In the Q4_FasterNetwork scenario, replace all 100BaseT links in the network with 10Gbps Ethernet links and replace all 10BaseT links with 100BaseT links. Study how increasing the bandwidth of the links affects the performance of the network in the new scenario (e.g., compare the HTTP page response time in the new scenario with that of the BusyNetwork).

4) Kreirajte novi scenarij kao duplikat BusyNetwork scenarija. Nazovite novi scenarij Q4_FasterNetwork. U Q4_FasterNetwork scenariju, zamijenite sve 100BaseT linkove u mreži s 10Gbps Ethernet linkovima i zamijenite sve 10BaseT linkove s 100BaseT linkovima. Proučite kako povećanje raspona linkova utječe na rad mreže u novom scenariju (npr. usporedite vrijeme odgovora HTTP stranice u novom scenariju s onim iz BusyNetwork).

Lab Report
9. Laboratorijski izvještaj

Prepare a report that follows the guidelines explained in Lab 0. The report should include the answers to the above exercises as well as the graphs you generated from the simulation scenarios. Discuss the results you obtained and compare these results with your expectations. Mention any anomalies or unexplained behaviors.

Pripremite izvještaj koji slijedi natuknice objašnjene u Vježbi 0. Izvještaj bi trebao uključivati odgovore na gore navedena pitanja kao i grafove koje ste dobili u simulacijskim scenarijima. Komentirajte dobivene rezultate i usporedite ih s vašim očekivanjima. Napomenite sve anomalije ili neobjašnjiva ponašanja.
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